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內容摘要： 

今年 4 月 22 日美國墨西哥灣發生的 Deepwater Horizon 溢油案，迄今共外洩

85 萬噸原油，為史上最嚴重的海洋油污染事件。美國政府為了因應本案特別成

立了聯合應變中心，並以 USCG 及 NOAA 為聯邦的應變主力，其中 USCG 負責

油污攔阻與清除，而 NOAA 負責所有的科技諮詢工作。NOAA 以下轄的海洋污

染應變與復育中心為主，負責提供聯合應變中心包含空中及水體的油污監測、溢

油模擬軟體、海岸敏感地圖、海上焚燒規範、及網路即時緊急應變指揮系統等相

關科學資訊。而 NOAA 的研發合作單位，華盛頓州立大學城市水污染中心及舊

金山灣基金會，則分別協助監測海灣水質與建置網路資源管理平台，並提供中立

的學術調查，消除民眾對散油劑對環境威脅等議題的疑慮。 
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壹、 目的 

今年 4 月 22 日美國墨西哥灣發生的 Deepwater Horizon 溢油案，迄今共

外洩 85 萬噸原油，為史上最嚴重的海洋油污染事件。美國政府為了因應本

案特別成立了聯合應變中心，中心的成員涵蓋了肇事者、聯邦政府、州政府、

學術研究機關、非營利的基金會、及相關業界專家。聯邦政府成員包含美國

國土安全部(Department of Homeland Security, DHS)、國防部(Department of 

Defense, DOD)、環保署(Environmental Protection Agency, EPA)、海洋暨大氣

總署(National Oceanic and Atmospheric Administration, NOAA)、海岸巡防隊

(United State Coast Guard, USCG)及州政府。並以 USCG 及 NOAA 為應變主

力，其中 USCG 負責油污攔阻與清除，而 NOAA 負責所有科技諮詢工作。 

NOAA 以下轄的海洋污染應變與復育中心為應變主力，負責提供聯合

應變中心包含空中及水體的油污監測、溢油模擬軟體（General NOAA 

Operational Modeling Environment, GNOME）、海岸敏感地圖（Environmental 

Sensitivity Index Maps, ESI）、海上焚燒規範、及網路即時緊急應變指揮系統

（Environmental Response Management Application, ERMA）等相關科學資

訊。而 NOAA 的研發合作單位，華盛頓州立大學城市水污染中心（University 

of Washington, Center for Urban Waters）及舊金山灣基金會（San Francisco 

Estuary Foundation, SFEI）則分別協助監測海灣水質與建置網路資源管理平

台。 
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藉由本次參訪，希期增進臺美雙方在海洋污染應變科技部分的交流，了

解美國各級單位對於環保事務的運作模式，同時環保署也將吸取美國在緊急

應變時科技部會的支援模式，來增進對海洋污染緊急應變的管理作法與技

術，以減少台灣與臨近海域船舶意外造成海洋污染的危害，進而保護太平洋

岸的居民、海洋生物免受台灣海面漏油及化學物質的影響。 
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貳、 行程簡介 

 

9 月 26 日 桃園國際機場飛往西雅圖 

9 月 27 日至 28 日 拜會 NOAA 海洋污染應變與復育中心 

9 月 29 日 拜會 Puget Sound Partnership 暨華盛頓大學城市

水污染中心 

9 月 30 日 拜會舊金山灣基金會 

10 月 1 日至 2 日 舊金山返回台灣 
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一. 參訪美國國家海洋暨大氣總署海洋污染應變及復育中心

（NOAA，Office Response and Restoration） 

 

（一） 前言 

美國發生重大海洋與海岸污染事件時，USCG 的 Strike Force 負責海

上及海岸的油污及化學品清除（武），而 NOAA 的海洋污染應變與復育

中心(Office of Response and Restoration, OR&R)則負責提供應變相關的

科技支援與後續的復育工作（文）。如本次墨西哥灣溢油事件，聯合應

變中心的政府部門便是由 USCG 及 NOAA 為主，其他單位為輔。 

NOAA 的海污應變依據為有三，分別是： 

1. National Oil and Hazardous Substances Contingency Plan  

2. National Response Framework (ESF-10) 

3. Emergency Planning and Community Right to Know Act  (SARA Title 

III Amendment) 

（二） NOAA 的組織架構 

NOAA 為美國商業部下轄之單位，總部位於 Silver Spring, 

Maryland，NOAA 下轄 5 大中心，分別是大氣暨海洋研究中心、國家氣

象中心、國家海洋中心、國家海洋漁業中心、及國家環境衛星資訊中心。

本次參訪對象是海洋污染應變與復育中心，但是亦有以電話與電子郵件

與位於 Virginia 的 NOAA 國家環境衛星資訊中心進行相關會議。 

其中海洋污染應變與復育中心隸屬於國家海洋中心，行政總部位於
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Silver Spring, Maryland，科技應變部門則位於 Seattle, Washington。 海

洋污染應變與復育中心下編 134 名員工，包含緊急應變部 45 人，海洋

垃圾部 10 人，環境復育部 45 人，及秘書部 26 人，另外該中心超過半

數員工擁有博士學位。緊急應變部於 1970 年初成立時只有 5 名人員，

1990 年 Exxon Valdez 案後擴編至 45 人，為因應墨西哥灣溢油案，該中

心暫時擴編至 150 人。近 10 年來，NOAA 平均每年處理 150 件海洋油、

化學及其他污染事件。 

（三） NOAA 的海污應變工作事項 

NOAA 的海洋污染應變與復育中心日常工作項目共有 3 大項： 

1. 海污應變： 

於海洋污染事件發生時（至少需要達到第 2 級），提供如空中海污

觀測、油污軌跡模擬、網路應變資源整合系統、應變方式評估及建議（如

海上焚燒）、海上（岸）化學品應變建議、海氣象觀測及預報、生態復

育等建議與資訊。 

2. 日常準備工作： 

繪製環境敏感指標地圖（ESI）、研發應變軟體、及辦理相關的訓練。 

3. 協調整合： 

於應變時協調整合海岸巡防署(USCG)、聯邦現場專家小組

(FOSC)、州政府、及相關的學者專家。該中心設有海洋科技人才資料

庫，鑒於海洋專家，如海洋生物專家，往往僅對海洋生物本身，但對油
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或化學品對生物的影響不清楚。所以該中心便設立科學家協調小組，小

組成員具有海洋污染對生物、水質影響的通用知識。於事件發生時，可

迅速與其他專家溝通協調，擬定出對當地環境的應變策略。 

目前該中心每年亦固定開設 30 人 3-5 天的科技應變研習營，課程

內容包含油污軌跡模擬，ESI 製作與判讀，及化學品應變等課程，及不

定期開設單項科技應變項目的線上或實體課程。 

而 NOAA 的國家環境衛星資訊中心則於海洋油污染事件發生時，

提供相關的衛星觀測報告。該中心為全時運作，可動用一般可見光衛星

及包含不受天候及於夜間運作的雷達衛星(SAR)。且與歐洲等其他國家

的衛星公司簽有合約，其可動用的衛星數量遠大於台灣。若軌道適宜，

該中心可於 3 小時內完成衛星的油污面積分析報告，而目前國內中央大

學太空遙測中心，分析可見光的衛星照片需時約 7 小時。 

 

（四） NOAA 海洋污染應變與復育中心的海污應變工具 

NOAA 的海洋污染應變與復育中心的應變工具共有 3 大類： 

1. 應變統整工具： 

如環境敏感指標地圖（ESI）及網路應變整合系統（ERMA）。 

2. 油污應變工具： 

 油污軌跡模擬軟體（GNOME），溢油諮詢資料庫（ADIOS2），及

溢油單位換算軟體（NUCOS）。 

3. 化學應變工具： 
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化學品空氣警戒區模擬軟體（ALOHA），化學品反應資料庫

（CAMEO），及海洋生物毒性模擬軟體（CAFÉ）。 

建置環境敏感指標地圖（ESI）是海洋污染應變與復育中心最重要

的日常工作，其以 30 公尺為間隔，涵蓋了美國沿岸所以的環境敏感資

訊。與其他國家的 ESI 地圖相比較，美國的環境敏感指標地圖並沒有包

含應變資源庫的位置及應變路徑建議，因為該中心認為環境敏感指標地

圖內容應專注於自然資源，若包含應變資訊可能會誤導現場應變指揮官

的決策。並且該中心的環境敏感指標地圖除了海岸地質與使用特性外，

尚包含了豐富的生物資訊。鑒於當地生物的成長與棲聚會隨季節而變

化，該中心的生物指標細分至每月並標示生物的幼生期、成長期及成熟

期。該中心並建議，所有的 ESI 地圖應有紙本（每一頁均需外包塑膠膜）、

電子地圖及地理資訊系統(GIS)等 3 種版本，因為在緊急狀況時，很有可

能喪失電力，所以該中心所有資料均有紙本備份。 

ERMA 是 NOAA 於 2010 年剛剛研發完成，提供指揮中心與前進指

揮所的即時網路諮詢系統，該系統可同時提供應變資源、海氣象預測、

溢油軌跡模擬、海面船隻資訊、及環境敏感指標地圖（ESI）等資訊，

同時依指揮官的需求顯示不同的圖資。 

GNOME 是海洋污染應變與復育中心自行開發的免費油污軌跡預測

軟體，其以商用軟體 Oil Map 為研發骨架，所以操作介面與原理非常相
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似 Oil Map。而此以模式的另一個優點或是與 Oil Map 不同之處，便是

可以使用不同的水理模式作為海流的模擬，不受限於數值網格方式或特

殊的水理模式。這是因為受到地形或水深的影響，我們亦會需要使用不

同的水理模式。例如，Princeton Ocean Model 在模擬大洋洋流上有其優

勢，但在模擬沿岸流時，當地科學家自行撰寫的水理模式可能更接近現

場海況。因此，NOAA 的科學家在使用 GNOME 時，常會搭配數個水理

模式，依其專業經驗選擇出最適合的模擬結果。另外，在做 GNOME 的

後續模擬校正時，該中心的科學家建議最好的發是便是以專業空中觀測

為主，其他遙測設備為輔。而運用該模式於台灣本島的最大挑戰，便是

需建置相關的數值邊界圖。 

ADIOS 2 是溢油諮詢資料庫軟體，內建數百種各式油品資料。是該

中心最廣為人知的軟體，該軟體除了可提供油品的基本資料，更可在輸

入現場溢油狀況及海氣象資料後，計算出溢油隨時間變化而揮發、消

散、與滯留海面的量。同時，該軟體更可模擬海上燃燒時所產生的煙柱

範圍，以及運用汲油器後對總溢油量的影響評估。 

化學應變軟體 ALOHA 已為本署毒管處做為模擬化學品空中警戒

區，此次參訪 NOAA 便教授如何將 ALOHA 的模擬結果展現在 Google 

Earth 上，已方便應變中心判讀。此外海洋污染應變與復育中心以正在

研發 ALOHA 的 3-D 版，未來 ALOHA 將能模擬化學品於水中及空中的
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3D 變化。 

CAMEO 是 EPA 與該中心聯合研發的化學應變軟體，其內含上萬種

化學物質，除可列出該化學物質的物質安全表（MSDS）、相對應的安全

防護、及消防準則外，更可模擬數個化學物質接觸，或化學物與水及空

氣接觸時的反應及安全注意事項，所以該軟體對於海上化學事故有著極

大的助益。
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與 NOAA 官員合影 

NOAA 的組織架構 



 12

 

 
NOAA 每年的海污應變數目 

 

 

 

 

NOAA 海洋污染應變與復育中心的海污應變項目 
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二. 參訪 Puget Sound Partnership 暨華盛頓州立大學城市

與水污染中心 

（一） 前言 

州政府與學術研究單位在美國發生重大海洋與海岸污染事件時，同

樣扮演了極重要的腳色。其中州政府部分，除牽涉到州政府與聯邦間的

分權互動，州政府內部的跨單位協調整合，更是值得我們探討學習的部

分。而本次參訪的華盛頓州立大學城市水污染中心，則是美國近來政府

與學術單位結合的新趨勢。 

（二） Puget Sound Partnership 

Puget Sound 涵蓋了加拿大、美國華盛頓州及奧勒岡州，是美洲西

北部最重要的水域。在涉及環境保護事務時，在美國華盛頓州領域便有

NOAA、EPA、軍方、華盛頓州生態部（Washington State, Department of 

Ecology）（該州無環保部的編制）及西雅圖市環保局等軍方政府單位的

參與。由於涉及聯邦、州、市、軍方及學術單位，所以往往無法有效整

合意見，並且浪費各種資源。有鑑於此，華盛頓州政府特別設立了 Puget 

Sound Partnership，此委員會直接隸屬於州長辦公室，其經費來源主要

來自 EPA、華盛頓州政府及民間捐助，並得以運用上述款項，提供各單

位對 Puget Sound 的研究經費。由於得到 EPA 與州長的授權與經費支

持，使得該組織能有效整合各級單位。目前 Puget Sound Partnership 目

前主要專注於下列事項： 
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1. 水域底泥中重金屬及致癌物質如 PAHs 的減量與移除。 

2. 暴雨對水質的影響。 

3. 總量管制（TMDL）。 

4. 國際合作，該組織與加拿大、日本、歐盟的官方環保單位均保持聯

繫，共同為保護環境資源而努力。 

（三） 華盛頓州立大學城市水污染中心 

學術研究單位在美國發生重大海洋與海岸污染事件時，亦扮演了極

重要角色，其除可提供專業意見，亦可藉其崇高的社會地位，在面臨重

大爭議時提出適當的環境保護意見。如此次墨西哥灣溢油案，針對散油

劑的使用與海底未知的油柱是否存在，便是依靠學術單位如聖地牙哥大

學、佛羅里達大學及華盛頓大學的中立調查做出結論。 

華盛頓州立大學城市水污染中心是由 Puget Sound Partnership 出

資，結合了 Tacoma 市、 NOAA 及華盛頓大學所成立的研究單位，並

於本次墨西哥灣溢油案中負責部分海灣水質及底泥監測的工作。該中心

另一個亮點是其結合綠建築與化學安全的建築設計，包含外牆的自動遮

陽調溫設計、水的再生利用、及實驗室用水的分離處理等。 



 18

 

與華盛頓州立大學城市與水污染中心主任 Joel Baker 教授合影 

 

城市與水污染中心外觀 
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城市與水污染中心的綠建築概念圖 (Center for Urban Waters) 

 

內部辦公室的節能設計
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三. 參訪舊金山灣基金會 

（一） 前言 

大型的非營利性的學術基金會在美國發生重大海洋與海岸污染事件

時，同樣扮演了極重要的角色，如 San Francisco Estuary Foundation、

Chesapeake Bay Foundation、Great Lake Environmental Center 等。這些基金

會均長期接受聯邦或地方政府委託，進行獨立的環境監測。其財務來源大

都來自政府補助、企業捐款、個人捐款及執行計畫所得。其中，政府補助

部分可以像是汽機車的特殊牌照費及指定環境檢測費。同時為了避免民眾

疑慮會受到補助單位的影響，基金會往往會設立兩道保護閥。第一道便是

多元的委員會成員。其成員包含各級政府代表、業界代表、大學教授及環

保團體。此外由於定位為學術基金會，各單位在派遣委員代表時，均會考

慮代表的專業能力與學經歷，並避免政治酬應。第二道保護閥則是請具有

從高學術聲望的專家擔任執行長。截至目前為止，美國民眾及學界對於此

類運行方式並無疑慮。 

（二） 舊金山灣基金會 

舊金山灣基金會屬於非營利的基金會，位於奧克蘭市共有 45 名員工，

本次墨西哥灣溢油案中負責協助建置網路資源管理平台。該基金會長期於

舊金山灣進行環境監測，監測項目包含水、空氣、底泥及生物。分析內容

除傳統水質檢測項目外，還包含有機致癌物如 PAHs、PCBs、PBDEs 及有
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機汞等。其所有的監測資料均公開上網免費提供外界下載。由於污染物對

自然生物的影響很大，該基金會特別針對生物毒性累積，及污染物經食物

鏈的作用，成立專門研究部門，並且強調在做環境監測時，不能只作水質、

底泥或空氣的監測，而須同時監測相關化學物質於周遭生物體內的變化。 

該基金會同時亦依監測分析資料，提供加州政府擬定相關法令。最新

的一個案例便是該會發現舊金山灣的含銅量過高，經長期的資料分析比

對，發現主要的來源竟是汽車的金屬煞車片。該基金會提報加州政府後，

加州政府便協調業者決定於 2025 年時，所有的汽車煞車片不得含銅。 



 22

 

與執行長 Rainer Hoenicke 合影 

 

與 SFEI 同仁合影
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肆、 心得與建議 

國內建立海污應變量能時，除了攔油索、吸油棉、應變船隻、汲油器及

散油劑等裝備之建置、操作維護及人員訓練外，有關科技在應變上的支援，

包含使用遙測工具、溢油模擬及環境敏感指標地圖等，雖亦持續進行，但此

部分涉及科技專業人才及投資經費，因此仍有相當大的努力空間。 

回顧這次墨西哥灣溢油案中，聯合應變中心由於獲得 NOAA 在溢油區

域模擬、空中遙測偵照、區域敏感地圖、溢油的物理化學特性、海上燃燒及

散油劑的使用時機、網路應變整合系統等資源協助，所以應變中心能在有限

時間與資源下，充分調度與使用應變能量。有鑒於此，美國聯邦政府亦準備

再次擴充該中心的專家數量及經費，以備不時之需。 

學術研究單位及非營利性的學術基金會，在美國發生重大海洋與海岸污

染事件時，亦扮演了極重要角色，其除可提供專業意見，亦可藉其崇高的社

會地位，在面臨重大爭議時提出適當的環境保護意見。如此次墨西哥灣溢油

案，針對散油劑的使用與海底未知的油柱是否存在等議題，便是依靠學術單

位的中立調查做出結論，消除民眾的疑慮。 

建議未來國內應整合有限的科技應變資源，妥善結合學術研究單位及非

營利性的學術基金會，強化各級應變人員對科技資源的認識，期能提升污染

應變之質量。 
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肆、 附件 

 

一、拜會名單 

 

 (一)、NOAA 

John Tarpley, 應變行動部主任 

Debbie Payton, 科技支援部主任 

Amy Mertin, 資訊整合部主任 

Mark Miller, 軟體發展部主任 

Jerry Galt, 溢油模擬部顧問（前應變中心主任） 

William Lehr, 資深科學家 

Michele Jacobi, 環境科學家 

Davida Streett, 衛星資訊中心主任 

 

(二)、Puget Sound Partnership 及華盛頓州立大學城市水污染中心 

Joel Baker, 華盛頓州立大學水污染中心主任兼 Puget Sound Partnership 科學總監 

David Dicks, Puget Sound Partnership 執行總監 

Chris Townsend, Puget Sound Partnership 執行總監特別助理 

Geoffrey Smyth, Tacoma 市 公共事務室主任 

Dana Leon, Tacoma 市 環境事務部資深經理 

 

(三)、舊金山灣基金會  

Rainer Hoenicke, 執行長 

Meg Sedlak, 計畫總監 

Donald Yee 環境科學家 

Susan Klosterhaus 環境科學家 
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二、美國國家海洋暨大氣總署海洋污染應變與復育中心簡報 
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Emergency Response 
Division (45)

Assessment and 
Restoration 
Division (45)

Marine Debris 
Division (10)

Office of Response 
and Restoration  
(134)

Business Services
(26)

4

Continuum of “Response” for the OR&R

Emergency 

Response Division

(ERD)

Response
(24 hours)

Restoration -
Recovery

(Years to 
Decades)

Assessment and 
Restoration Division

(ARD)
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Mandates/Drivers

 National Oil and Hazardous Substances 
Contingency Plan 

 National Response Framework (ESF-10)

 Emergency Planning and Community Right to 
Know Act (SARA Title III Amendment)

Providing accurate, timely, and credible 
scientific advice to commands charged with 
mitigating the effects of spills and other 
coastal hazards.

What We Do

 Response: modeling, shoreline assessment, 
biological and resource assessment, weather 
coordination, overflights, data management, 
communications

 Preparedness: drill support, guidelines, ESIs, 
training and outreach

 Development: tools, models, web access

 Coordination: Other Federal Agencies, States, 
academia, IOOS
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Number of ERD Spill 
Responses

29



RResponse Requirements
 Provide 24/7 scientific support during oil and 

hazardous material releases
 Identify, assess, prioritize, and mitigate injuries 

caused by hazardous material releases
 Accelerate restoration and recovery by integrating 

habitat improvement into response actions
 Provide credible, timely and appropriate advice
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Scientific Support Coordinators

 The Scientific Support Coordinators are staff advisors to 
Federal On-Scene Coordinators (FOSC) responsible for 
coordinating the scientific aspects of spill response

Steve Lehmann

Ed Levine

Frank Csulak

Brad Benggio

Charlie Henry

Jordan Stout

Ruth Yender

John Whitney

LCDR Liz Jones

Ruth Yender

What happened?

Where does it go?

Who does it hit?

How does it hurt?

So what?
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NOAA Scientific Support Includes:

 Science coordination
 Trust resource representation
 Weather/Trajectory forecasts
 Chemical assessment/analysis
 Resources at Risk assessment
 Field assessments (shoreline 

and aerial)
 Protection/Cleanup 

recommendations and 
priorities

 Information management
 Remediation/Restoration 

review
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Insert picture of response booms/etc.

Preparedness

 Drills:  20‐40 per year, every other year a 
major drill (SONS, TOPOFF, etc.)

 Guidelines:  Job Aids, Standards (ESI, SCAT)

 ESIs:  Atlases for all US Coastline (1:24,000) 
with biological, socioeconomic and cultural 
resources mapped against shoreline type and 
sensitivity to oil

 Training and Outreach :  approximately 1,000 
people/year, significant variation in 
length/type of training provided
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Development

 Models (GNOME, ADIOS, ALOHA,CATS)

 Tools (Converters, GOODS, SHIO, CAMEO, 
MapBox, CAFÉ, CRW)

ERD R&D focus

 Improve 3D modeling

» Subsurface Circulation/Transport Improvements

 Waterborne Chemical Fate (CAFÉ)

 Playing with others  (IOOS, MAST, DMAC, SS drill, Agency 
MOAs, GOODS)

 CAMEO/ALOHA Improvements and Extensions

 Understanding/Describing Uncertainty

 Approaches to assessing risk (ChemTAP, ERA)

 Better field tools/data management (eSCAT, photologger)

 Historical information, info dissemination
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 It’s all about the HOP!! (Hazmat Operating Plan)

 Five Goals (align with last strategic plan, 
address Goal 0 to align with OR&R):  
Response, Preparedness, Training, R&D, 
Improving the Organization

 Goal 0:  Regaining Leadership as Responders, 
Building Response Capacity, Reaching Inward, 
Investing in Growth Areas, Managing for 
Performance

 HOP . . . ProjectTracker . . . . Performance Plans

Annual Planning

36



EXTRAS . . . . 
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3D Modeling Workgroup

FY09  approximately 3.5 FTE
FY10 approximately 5 FTE
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Critical Datasets for Environmental Response
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Natural Resources at Risk

 ESIs

 ESI Maps

 RARs

 Endangered Species

 Manager Consultations
 Planning

 Spill Response

 Post‐Incident

 Ecological Risk Assessments

NOAA Trust Resources
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CAMEO: Planning and Response 
Tool

 Search for response recommendations for over 5,000 
chemicals. 

 Predict hazards if chemicals mixed using the 
Reactivity Worksheet.

 Estimate threat zones for chemical releases using 
ALOHA.

 Link information to map objects (such as chemical 
facilities) in MARPLOT.

 Manage Emergency Planning and Community Right-to-
Know Act (EPCRA) data using the other modules (such 
as Chemical Inventory).

 Over 10,000 National/International users

Chemical Aquatic Fate & 
Effects database (CAFÉ)

 Internal Tool to provide 
quicker access for 
assessing risk 

 Over 3,000 chemicals

 Based on EPA EcoTox
database and Syracuse 
Physical property 
database

 Undergoing review, 
qa/qc, pulse‐exposure 
research
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三、美國國家海洋暨大氣總署環境敏感指標地圖製作教學大

綱 
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Purpose of this Manual 
 
The goal of this document is to introduce how the Environmental Sensitivity Index, or 
ESI, maps and data can be utilized. We will look at an oil spill scenario, and the task 
will be to identify the probable resources at risk. The ESI data are distributed in multiple 
formats. This manual will look at how to use the hard copy/PDF version of the data, the 
free ESI-viewer product, and, if you have ESRI’s ArcMap (vs. 9.2 or higher) installed, 
how to use the map document and tools available to simplify ESI viewing and querying.  
The same scenario will be used for all of these formats, and the same basic questions 
will be answered. As you go through the scenario queries, you will hopefully think of 
other questions you might want to answer and other situations where the data on the ESI 
maps might be useful. The scenario provided takes place in Mobile Bay, but these same 
queries could be done on any of the ESI maps provided in these formats. 
 
Supporting Materials 
 
A portable document format (PDF) version of this document and all of the supporting 
data referenced in this tutorial can be downloaded from 
http://response.restoration.noaa.gov/ESI_Training.  If you have an original hardcopy of 
this manual, these documents may also be found on the “ESI_Training” CD inserted on 
the back cover. Included are the following directories: 
 

-  ESI_VIEW: Installers for both Macintosh and Windows platforms of the 
Alabama ESI data and free software for viewing and querying 

-  GEODATABASE: Alabama ESI in ESRI’s geodatabase format and an ArcMap 
document with database links and symbolization pre-set 

-  PDFS: The entire Alabama ESI atlas in Portable Document Format 
-  GNOME: GNOME.dll, a tool to import trajectories generated by GNOME 

Analyst, and a directory called “scenario” which has the GNOME export files for 
the Mobile Bay scenario 

-  ESI_Tutorial.pdf: This document in PDF format 
-  ESI_Tools: Four .dll files for use with the ESI data from within ArcMap and 

supporting documentation 
 

It is recommended that the entire contents of the training CD be copied on to your hard drive and 
placed in a directory call ESI_Training. That way the pathnames will match those that appear in 
this tutorial. If you choose to create your own directory, do not include spaces in the name. 
ArcMap will not work with pathnames that have embedded spaces.
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Using this Manual with Other ESI Atlases 
 
The methods outlined in this manual can be applied to any of the ESI atlases. The only 
differences will be the area covered by the trajectory and the resources impacted. 
Because a GNOME trajectory may not be available for your area, Appendix B gives 
instructions on how to draw your own trajectory footprint for use in ArcMap.  
 
If you are using an ESI CD/DVD other than the ESI Training CD, you will access the 
directory PDFS for section 1. For the ArcMap section, copy to your hard drive the entire 
directory named for your atlas (i.e. Alabama) from inside the directory 
GEODATABASE. (DVDs that contain multiple atlases will have the name of the atlas 
twice in this pathname, i.e. Alabama/GEODATABASE/Alabama.) Make sure there are 
no spaces in any of the directories that comprise the pathname to the geodatabase. 
ArcMap cannot handle embedded spaces.  
 
The installers for the ESI Viewer section will be found in the directory ESI_VIEW.  If 
you are working from a CD or DVD that does not have a GEODATABASE directory, 
this is an atlas that was published before that technology was supported. It also means 
that the ESI Viewer software is pre OS-X on the Macintosh platform and pre Vista on 
the Windows platform. Visit the ESI page at http://response.restoration.noaa.gov/esi and 
follow the links to ESI status. There you can download the PDF Status of OR&R’s ESI 
Products, which lists all of the available formats. On that same page, follow the link Get 
ESI Maps and GIS Data to find ordering information or download instructions from the 
NOS Data Explorer site. 
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Introduction to ESI Maps 
 
In the event of an oil spill, responders must quickly decide which locations along the 
shoreline to protect. To do this effectively, they first need to assess which areas would 
suffer the greatest consequence if impacted by the spill. Since there will be limited 
response equipment available, they will want to focus their efforts on the more sensitive 
shoreline areas and the areas where sensitive biological and human resources are found.  
 
Environmental Sensitivity Index (ESI) maps can be a valuable tool in this process. The 
ESI maps systematically compile information of three types: 

 
- Shoreline type 
- Biological resources 
- Human-use resources 

 
The shoreline is ranked on a scale from 1 to 10 based on sensitivity to oiling determined 
by: 

 
o Relative exposure to wave and tidal energy 
o Biological productivity and sensitivity 
o Substrate type (grain size, mobility, penetration and trafficability) 
o Shoreline slope 
o Ease of cleanup 
o Ease of restoration 

 
Optimally, the priority would be to protect the shorelines ranked with the higher values, 
as these are the more sensitive areas and the areas where oil would be more apt to persist 
and cleanup, if even possible, would be the most difficult.  
 
The biological resources mapped include birds, fish, invertebrates, marine mammals, 
terrestrial mammals, and habitats (eelgrass, kelp, etc). In ESI terms, these are called 
“elements”. When deciding what to map, emphasis is placed on: 

 
o Rare, threatened, endangered, and special concern species 
o Commercial and recreational species 
o Species of significance to the local community 
o Areas of high concentration 
o Areas where sensitive life-history stages or activities occur 
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When evaluating protection strategies, it is important to consider which species are most 
likely to be adversely affected by oiling at the time the spill occurs. Seasonality plays a 
significant role in where members of a particular species will congregate, and what life 
stages will be found. The ESI maps not only show the probable location and extent of 
various species, they also have supporting data tables that indicate the monthly presence 
and breeding activities. Other information includes concentration, threatened/endangered 
status, and, in the case of the digital data, source level metadata that can assist in 
identifying the local experts for “real time” information.  
 
Human use resources mapped are those that might be sensitive to oil, useful during 
response operations, or may be vulnerable during response activities. These may 
include: 

 
o High-use recreational and shoreline access areas 
o Officially designated natural resource management areas 
o Resource extraction sites 
o Cultural resources 

 
These resources should be considered from a variety of perspectives. Some of these 
resources may be sensitive to oiling; others may be even more vulnerable to damage 
from cleanup equipment or responder traffic. Still other resources mapped may be useful 
in determining possible access or staging locations.  
 
All together, the resources mapped on the ESI provide a very good starting point for 
planners and responders in the event of a spill. However it is important to remember the 
data reflect the conditions that existed at the time the maps were made. All of these 
resources have the potential to change. Local management agencies and experts should 
be contacted as soon as possible to verify the actual conditions at the time of the spill. 
 
For information specific to the ESI you are working with, or to get a broader discussion 
of the ESI product, read the INTRO.pdf located in ESI_Training\PDFS\ESI_DATA or 
in the PDFS\ESI_DATA directory of your atlas CD. 
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Spill Scenario 
 
On April 18, 2008, a storm hits the Mobile Bay area (Alabama, USA). The 
winds are primarily from the west. At 08:00, a vessel crossing the main ship 
channel and heading north to the Mobile port, suffers a leak and an oil spill 
occurs. 1000 barrels of medium crude oil is spilled. The release point is 30º 
28.33’ N, 88º 01.07’ W during a flow tide. Within the first hour after the spill, 
the oil reaches the Gaillard Island shoreline. Ten hours later, about 8 miles of 
the east coast of the bay (from Great Pt Clear to Fish River Pt) are also 
affected. When the storm ends, the winds are from the southeast, the 
predominant weather pattern for the region. The oil that remains in the water is 
carried to the northwest area of the bay. It again impacts the Gaillard Island 
shoreline as well as the west coast of Mobile Bay. 
 
In order to understand how ESIs can be used to assess the resources at risk, this 
exercise will focus on the area projected to be impacted ten hours after the 
release. On the next page you will see output from the GNOME model, another 
product of NOAA’s Emergency Response Division (ERD). GNOME uses 
wind and current data to predict where spilled oil will travel. Here the 
trajectory has been imported into ArcMap and symbolized. As a general rule, it 
is best to consider the entire area within the uncertainty bounds (the red 
footprint) when establishing priorities.  Overlaid on the map, is the Alabama 
Index layer. This will help identify the maps we need to use. 
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Section 1: Using the hard copy and PDF versions of the maps 

For this section, you will need the PDF directory provided either on the ESI Training CD, 
or available at http://response.restoration.noaa.gov/ESI_Training. You may also use the 
PDFs provided on the Gulf ESI DVD, in the Alabama directory. Open the Alabama index 
(PDFS\ESI_DATA\INDEX.PDF) by double-clicking the file icon. In addition to being 
the title page, this PDF shows the extent of the Alabama mapping project, and the area 
covered by each of the maps. You will see that the ESI maps impacted by our scenario 
are numbers 10 and 19. 

As you move your cursor over the map 
index, it will become a pointing finger. With 
this cursor active, click inside the outline of 

map 19. This will navigate you away from 
the map index and to map 19, as shown here. 
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According to the trajectory, there is a possibility of oiling throughout this area. Look 
first at the shoreline types involved.  
 
On this map, the color coded shoreline is a bit difficult to see, because of the red reptile 
polygon that is spanning the coastline. Zooming in makes it a bit easier to discern the 
affected shoreline types.   
 
Below, a portion of the ESI-19 shoreline is shown. There are shoreline segments color-
coded with blue, purple, and blue and purple. (A shoreline segment may actually have 
up to three different types associated with it.) Looking at the legend at the bottom of the 
map, you will see these colors represent shoreline types 1B – Exposed, solid man-made 
structures (purple) and 3A – Fine to medium-grained sand beaches (blue), or a 
combination of these two types. Because the color-coding for types 3A and 3B are the 
same, on the map you can not be sure which of those two types are represented. With 
the digital data you will find you can easily make that distinction. 
 

 

1B/3A – Exposed, solid man-made structures/ 
Fine- to medium-grained sand beach 

1B – Exposed, solid man-made structures 

3A – Fine- to medium-grained sand 
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Additional information about the types of shorelines, predicted oil behavior and response 
considerations can be found in the atlas introductory pages. These are always included in 
the PDFS directory on the atlas CD/DVD. A representative photo of each shoreline type 
is also included. Here is a sample for shoreline type 3A from the Alabama atlas: 
       

 
 
 
 
Now consider the biological resources. Some of these are mapped using color coded 
hatch patterns, to illustrate the extent of a mapped species, or group of species. On this 
map there are bird polygons – green, reptile polygons – red, habitat polygons – purple 
and invertebrate polygons – orange. In some cases, where a polygon represents multiple 
elements, it may be shown with a black hatch pattern to simplify the presentation.  
 
Associated with each polygon will be one or more icons and a number. The icons can be 
helpful for a quick visual assessment. They show which “subelements” are found in that 
area. This is a grouping of species with similar life habits, such as habitat preference or 
feeding styles; an example is raptors. The number is called the Resource at Risk number, 
or RAR#. It references a listing on the back of the map (scroll down to page 2 of the map 
PDF) of all the associated species, their seasonality and other useful information, such as 
concentration, when available, and their threatened/endangered status. 
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In the lower left side of the map, you will also see a number of icons and RAR#s 

presented in a box with a textual description as to where the species are 
found. These boxes, nicknamed the “common throughout” boxes, are 
created to minimize clutter on the map. With the digital data, polygons 
of these areas are retained, so the user can query the data for location 
and extent. There are examples of this in the following sections. 
 

In the case of the scenario presented, the entire area on map 19 is impacted by the spilled 
oil, so we can start out considering all of the species on the back of the map as potentially 
“at risk”. Now is when the seasonality information can help to narrow down what species 
are particularly vulnerable. Below is the seasonality summary for just the birds on map 19. 
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The records with species that are present in April are all highlighted. Any species that is 
nesting in a particular area on this map during April, potentially increasing their vulnerability, 
is highlighted in red. The two species highlighted in blue may be of special concern because 
they are listed by the state as “protected”. Of course it is important to remember this is just a 
starting point in developing protection priorities. If a spill happens at either the beginning or 
end of a month, or if the weather conditions are particularly harsh or mild for a season, it may 
be a good idea to window your observations to include either the month prior or following 
that of the event. Of course, because ESI mapping is really a snapshot in time, it is imperative 
to check with the regional experts to verify if these conditions are in fact valid at the time of 
the spill. This is another case where the intro pages are useful. The sources of the resources 
mapped, will always be listed there. In the Alabama atlas, there are actually local expert 
names and numbers to help responders access timely, updated information. Other general 
information about the species mapped is also included. An excerpt is shown below. 

BIRDS 

Bird concentration areas depicted in this atlas include:  

Waterbird and shorebird nesting and wintering sites – Locations 
where waterbirds (e.g., herons, egrets, skimmers, pelicans, 
terns, shorebirds, etc.) have been documented as nesting 
are mapped.  Colony size (number of birds present) is 
included in tables on the reverse side of the maps and was 
provided by State biologists. Piping plovers (federally 
threatened) winter  along the Gulf and Mississippi Sound. 
Designated critical habitat occurs in this area.   

Waterfowl, diving bird, and pelagic bird migratory staging and 
wintering – Concentration areas are shown for migratory 
and wintering waterfowl, diving birds, pelagic birds, and 
gulls/terns in Mississippi Sound, Mobile Bay, Perdido Bay, 
Gulf of Mexico, and associated smaller bays, rivers, and 
marshes. Alabama DWFF and DCNR provided distribution 
information based on many years of surveys and field 
expertise. Waterfowl nesting areas are mapped, most 
commonly for Canada goose, mottled duck, mallard, snow 
goose, and occasionally for other species in wetlands when 
information was available.  

Migratory shorebird stopover areas – Sites where large 
concentrations of shorebirds occur annually, particularly 
during the spring and autumn months, are mapped along 
the Gulf Coast, the Delta, and other areas as appropriate.  

Marsh birds, raptors, and passerine species – General locations 
of marsh birds (e.g., rails), raptors (e.g., eagles, osprey; 
nesting habitat/sites are depicted), and passerine species of 
concern (e.g., some sparrow species), particularly 
threatened and endangered species, were mapped.  

 

 

 
 
  Major Data Sources Used: Birds 
 
Alabama Natural Heritage Program. 2006. Alabama Natural Heritage 
Program Element Occurrence Data for Rare and Endangered Species in 
Alabama, vector digital data. 

Imhof, T.A. 1976. Alabama Birds. Second Edition. The University of 
Alabama Press, 445 pp. 

Mirarchi, R.E., Bailey, M.A., Haggerty, T.M., and Best, T.L. 2004. 
Alabama Wildlife, Volume Three: Imperiled Amphibians, Reptiles, 
Birds, and Mammals. The University of Alabama Press, Tuscaloosa, 
AL, 225 pp.   

USFWS. 2001. Piping plover critical habitat – wintering grounds, vector 
digital data 

. 
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A number of human use resources are also found on ESI map 19. Some unnamed historic 
and archaeological sites are shown, as well as some marinas and boat ramps that reference 
supporting information via a human use number, or HUN# (the equivalent of the RAR# 
used with the biological resources). An example symbol and its related reference on the 
back of the map appear below. When a contact name and/or number are available or 
appropriate, they are also provided. 
 
 
 

              

 
 
 
 
 
 
 
 
We have now examined all of the resources mapped on ESI 19. To complete the inventory 
of resources at risk by the given spill scenario, the same process would be repeated on the 
impacted areas on ESI 10.  
 
Using the PDF and/or hardcopy ESI maps has both advantages and disadvantages. It is 
relatively simple to do and does not require knowledge of any specialized software 
products. However, it is not easy to extract the information to create a resource summary, 
nor to visualize the integration of data from other sources. In the following sections, you 
will see how Geographic Information System (GIS) software can make many of these 
tasks much easier. 

Archaeological Sites 
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Section 2: Using ESRI’s ArcMap with the ESI map document and tools 
 
For this section, you will need ESRI’s ArcMap installed on your computer (vs. 9.2 or 
later). If you don’t have access to this software, you may want to read through the first few 
pages (up to Task 1), then skip to the section titled ESI Viewer. There you will be guided 
on how to install and use the free ESI Viewer software that allows you to perform many of 
the same types of queries that are outlined here. 
 
The first step is to get the ESRI geodatabase and map document on your local computer. 
From the training CD, copy the directory ESI_Training/GEODATABASE/Alabama in its 
entirety onto your hard drive. (You may also download this directory from 
http://response.restoration.noaa.gov/ESI_Training). Launch the Alabama ESI map project 
by double-clicking the alabamaESI.mxd icon, or by opening it from within ArcMap. The 
startup screen will look something like this: 
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Initially, only the hydro and index layers are turned on. You may turn other layers on and off 
by selecting the checkbox next to the layer name in the legend window on the left. Try turning 
on some of the biology layers. You will notice that the GIS “maps” look very different from 
the cartographic product found on the hard copy ESI maps and the PDF version. In particular, 
look at the ArcMap window with the fish layer turned on. Now turn that off, and turn the 
reptile layer on. Remember the “common throughout” boxes discussed in the last section? 
Here you are seeing the underlying data, rather than the cartographic presentation intended to 
make the maps more readable and visually pleasing. In order to get answers to spatial queries, 
the polygons are needed to show both the location and extent of the mapped species. 

Below is an example comparing the ESI-19 PDF with its appearance in ArcMap. Aside from 
the polygons that now totally cover the water, you might notice that the aspect ratio of the 
map with the fish polygons is quite different than that of the PDF.  This is because the GIS 
data is distributed in un-projected, geographic coordinates. This format was chosen because 
with ESI coverage virtually nation-wide, the ideal projection, or at the very least, the 
parameters of a given projection, will vary from one atlas to another. Geographic coordinates 
allow consistency across the country, and make it easy to integrate multiple atlases. The 
downside of this is that as you move away from the equator, the map display becomes 
distorted. Whereas one degree of longitude = one degree of latitude at the equator, as you 
move towards the poles a degree of longitude becomes increasingly shorter than the degree of 
latitude. In the un-projected view, this reality is not taken into account.  
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As you will see in Task 1, it is easy enough to change the display projection so that the 
appearance of the data is a bit more realistic.  
 
Task 1: Change the display projection: 

 
a) Right click on the data frame name, Layers.  
 
b) Select Properties… 
 
c) On the Coordinate System tab, open the folder  
 Predefined/Projected Coordinate Systems/UTM/NAD 1927 
 
d) For Alabama, select NAD 1927 UTM Zone 16N 
 
e) Click OK 
 
If you are working with an atlas other than Alabama, there is a chart at 
the end of this document that will help you determine what UTM zone 

is appropriate. The zone will vary depending on the longitude of your map. (There may 
also be times when a UTM, NAD 1983 projection should be used, rather than NAD27. 
Check the metadata to verify the datum of the source data.) 
 
GNOME 
 
GNOME is an oil spill trajectory model developed and used by NOAA’s Office of 
Response and Restoration both for spill planning and response. Drawing on input 
describing the location of the spilled oil, the weather conditions, and tidal and current 
information, GNOME will predict where the spilled oil will travel. The oil is represented 
by hundreds of discrete points, called SPLOTS, which travel independently. In some 
cases, a second program called GNOME Analyst is used to generate polygon contours 
from the GNOME output. These contours can be exported from GNOME Analyst as a 
group of MOSS files, a simple text format for geographic data.  
 
An ArcMap tool has been developed to import the GNOME Analyst trajectory contours. 
In the next steps, we will add the GNOME Import tool and bring in the trajectory for the 
tenth hour of the spill scenario. For this exercise, you will need to load on to your 
computer the GNOME directory found on the tutorial CD or at the 
http://response.restoration.noaa.gov/ESI_Training. 
 
If you are not working with the Alabama training materials, you can still use this 
tutorial to learn about the ESIs in ArcMap. Skip tasks 2 and 3 below. Instead, go to the 
back of this tutorial and in Appendix B, you will see how you can draw in your own 
trajectory footprint. In the later tasks, you will use the trajectory you created the same as 
the trajectory imported below. 
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c

d 

b 

 
 
Task 2: Add the GNOME Import tool: 
 
a) Right-click on the ArcMap toolbar and scroll down to Customize... (or choose the 

Customize... option under the Tools menu). 
b) Select the Commands tab on the Customize window. 

c) Click the Add from file... button. 
Navigate to the gnome.dll file on 
your hard drive. Select the file 
and click Open to add the 
GNOME Import Tool to your 
available tools. Click OK.  

d) In the bottom, left-hand corner of 
the Customize dialog box, choose 
to save the tool with the  
alabamaESI.mxd  

e) In the scrollable list on the left 
side of the Customize... window, 
highlight ArcObject Tools. To the 
right, you should see the GNOME 
Import Tool vs. 2.0.  

f) Click on the GNOME icon and drag it onto your standard tool bar. Release the mouse 
button when your cursor becomes a vertical bar. (You need to release the mouse button 
at or before the last icon on your toolbar.) 

g) Exit the Customize… window by clicking Close. The GNOME Trajectory Import Tool 
is now ready to use. 

 

Task 3: Import the GNOME trajectory: 

a) Click on the GNOME tool icon.   

b) Highlight Import GNOME Trajectory Analysis, and hit OK. 
c) Navigate to the GNOME trajectory files for the Alabama scenario. The files will be in 

ESI_Training/GNOME/Scenario. Highlight scenario.ms1 and hit Open. 
d) Specify where you would like the trajectory geodatabase to reside, and what you would 

like it called. The default will put it in the same directory as the input files, with the 
root being the same as that of the input. In this case it is called scenarioContours.mdb. 
Click Save. 

e) A dialog box will come up that describes shoreline clipping options. Click OK. 
f) We are going to clip the trajectory to the ESI shoreline. In the Select Shoreline dialog 

box, highlight option 1, User Shoreline. Click OK. 
g) A dialog box with all the polygon layers listed will appear. Highlight hydro and click 

OK. 
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The import process will take a minute or two. At the conclusion of the import and 
clipping, you will be in an ArcMap Layout View, similar to the one that appears on page 
8. At the bottom, there is a scale bar that shows the relative coverage of each of the oiling 
categories. It is essential to keep this information with any trajectory that is distributed, as 
the light, medium and heavy classifications are always relative. 
 
The uncertainty contour reflects the potential variability of the winds and currents from 
those that were input and used to generate the trajectory. In general, it is wise to consider 
the entire area within the uncertainty bounds when establishing protection priorities and 
determining resources at risk. That will be the approach we use here. 
 
 
The ESI database is a fairly complex set of relational tables. To make using and querying 
the data within ArcMap a little bit easier, four ESI tools have been developed. We will add 
these to our ArcMap document now, in the same manner as we added the GNOME Import 
tool. 
 
Task 4: Create an ESI Toolbar and add the ESI mapping tools:  
  
Before starting this task, it is a good idea to verify that you have the 
latest release of each of the ESI tools. Whenever bug fixes or 
enhancements are made, a new version is posted to the OR&R 
website at: http://response.restoration.noaa.gov/esitoolkit.  The 
tools on the training CD were current as of March 30, 2008. If any of the tools on the above site 
have a release date after April 3, 2008, replace those on the training CD located in the 
ESI_Training/ESI_Tools  directory. The ESI tools were developed in ArcMap 9.2 and are not 
compatible with earlier versions. 
 
To add the ESI tools and/or to do any data analysis, you will need to be in the Data view 
window. (Importing the GNOME trajectory put you into Layout view mode). Under the View 
menu, select Data View. 
 
Create the toolbar:   

a) Right-click on the ArcMap 
toolbar and scroll down to 
Customize... (or choose option 
Customize... under the Tools 
menu). 

b) Select the Toolbars tab on the 
Customize window. 

c) On the right side, click New…  

d) In the pop-up window, name the toolbar ESITools and save it in alabamaESI.mxd. 
Click OK. The new ESITools bar will be added to your data window. 

 



 22 

Add the tools: 
e) Now click the Commands tab in the 

Customize window. 
f) Click Add from file.... Navigate to 

ESI_Training/ESI_Tools . One at a 
time, add the four ESI tools. You can 
do this by double-clicking the icon, 
then clicking OK in the pop-up 
window, or you can select the tool 
name, and click Open, then OK.  As 
the tools are added, they will show up 
in the right hand Commands: panel of 
the Customize window. 

g) After the tools have been added, drag each of them onto the ESI Tools toolbar. To do this, 
select the icon and drag it on to the toolbar. Release the mouse button when the cursor 
becomes a vertical bar.  

h) Close the Customize window. 
 
 
Task 5: Identify the ESI types of the impacted shoreline segments: 
 
 

We are now ready to look 
at the resources that might 
be impacted by the April 
spill scenario. Check the 
checkbox next to the esi 
lines layer to make it 
visible.  Use the zoom and 
pan tools on the “Tool” 
toolbar to focus on the 
trajectory area.  
 
Investigate the types of 
shoreline that might get 
oiled. One way to do this is 

to select individual shoreline segments using the Identify tool. Set the Identify from: layer to 
“esi lines”. Click on a variety of lines to see their ESI value. Here is an identify example with a 
value of 8B. 
 
You may also do a quick assessment of the impacted shoreline types by their color. Remember 
“hotter” colors (like red) are the more sensitive shoreline segments. Cooler colors (like purple 
and blue) indicate less sensitive shoreline types. In the ESI ArcMap document, shoreline 
segments that have multiple values will be color coded using the most sensitive shoreline type 
included. For the table item, MOSTSENSIT (on which the map legend is based), these lines will 
be labeled with the highest ESI value involved followed by a “+” sign to indicate there are other 
shoreline types associate with that segment. The table item ESI will list all of the ESI types.   



 23

 
 
It is also possible to do a spatial query that identifies all of the shoreline segments that fall 
within the trajectory uncertainty bounds. 
 

 
a) Under the Selection menu, choose Select by Location… 

 
b) In the dialog box: 

 

                            
 
 

 
c) Open the attribute table for the esi lines layer. To do this, right click on the layer name 

esi lines in the legend window and select Open Attribute Table. You should see a table 
that looks something like this: 

 

 
  
 
 
 

1. Set I want to:  to select features from

2. Set the selectable layer to esi lines 

3. Set the spatial operation to intersect 

4. Set the intersect layer to Trajectory 

5. Click OK

Click on Selected  to view 
only the impacted segments 

There are 19 shoreline 
segments selected

ESI types 
Segment length in 
decimal degrees 
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d) You may now create a table, showing only the selected objects and the most pertinent 

fields. Click on the Options button and select Reports > Create Report… 
 

 
 

e) In the Report Properties window, highlight the desired fields for the report and add them 
by clicking on the arrow key as shown below. For this report, the fields ESI, 
MOSTSENSIT, and Length will be included: 

 

 
 
 

f) Click Generate Report.  
g) At the top of the report will be a menu item called Export. This item will allow you to 

export the report either as a text file or as a PDF. Choose to export it as a PDF. 

Unfortunately, this process is a bit cumbersome, and the result shows all of the segments 
individually, even if they are duplicates of the same ESI type. In addition, a length shown in 
decimal degrees is not particularly useful. It is planned to add a tool to export a more useful 
ESI line report to the ESI Toolbar. This may either be a new tool, or a modification to the 

current Report Generator tool.   Remember to check the website for updates! 

h) Close the esi lines attribute window, and turn off the visibility of the esi line layer. 
 

Highlight the name, then click the 
arrow to add the field Length 

Make sure the box Use Selected Set is checked 
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Task 6: Use the ESI select layer tool to identify the impacted birds: 
 
a) Turn on the visibility of the birds layer, and zoom into the impacted spill area. 
b) Set the layer to query using the ESI select layer tool . When you click on this tool, 

you will see the following window:  
c) Set the biology layer to query to birds. This 

is a drop down menu that will give you the 
option of selecting any of the biology layers 
that are linked to the Biofile table, the table 
with all of the relevant attributes for the 
biology layers. 

d) Click the Select the fields to display button. In 
the pop-up window, you will have the option of 
setting the Biofile fields that are of interest. 
Below are the default values, or those set by 
checking Select All General Info. 

e) Click OK  in both windows to 
continue. 

 
Once a biology layer has been 
selected, you may use any of the 
ArcMap methods to select objects 
and see which species are present. 
Use the Select Features tool  to 
examine a few of the bird polygons 
within the spill area. The bird species 
present, and their related attributes, 
will show up in the biofile window.  
 
If you set the display properties to the 
General Info option, you will see the 
species common and scientific 
names, concentration information if available, a summary of the seasonality when each 
species is present, and information regarding their threatened or endangered status. 
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Now we will use the Select by Location option to identify the bird polygons impacted 
by the trajectory and to see the species they represent. The instructions that follow are 
an abbreviated version of those outlined in the ESI identification section. If necessary, 
refer back to steps a and b of Task 5 for a graphic example of how to set the Select by 
Location criteria. 

 
f) Under the Selection menu, choose Select by Location. Set the selection criteria as 

follows:  

1. I want to: Select features from: 
2. the following layer(s): birds (make sure all other layers are unchecked) 
3. that:  intersect 
4. the features in this layer: trajectory 
5. apply a buffer to the features in trajectory of: 250 meters 
6. Click OK 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

a 

b 
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The selected polygons are highlighted in blue. Notice that the entire polygon is selected if even 
a portion of it intersects the trajectory layer (a), and that some of the land bound polygons are 
included (b). The latter is because we set the buffer distance to 250 meters.   
 
The impacted species records are highlighted and shown in the Biofile table. You might find 
that some species names are listed multiple times in the table and they may even have different 
seasonal summaries or concentrations listed. This is because there will be a record for each 
species present, for each polygon. The life history, seasonality and concentration information 
will be specific to the polygon and species indicated.  
 
There are 79 records currently selected in the Biofile. In the next step, we will narrow the 
selection down to the records where the species are present in April, the time frame of our 
scenario. 
 
Task 7: Narrow the selected records to species present in April: 

a) Click on the Query Biology by Attribute tool.  

1. Set drop down Biology Layer  menu to “birds” 

2. Check the Apr seasonality box 

3. Check the Limit query to currently selected objects 

4. Click OK. 
 

    
 
 
 

 

1 

2 

3 
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This reduces the number of bird records selected to 59, but all the polygons that were 
originally selected remain selected. It may be helpful to be even more restrictive in your 
selection criteria. You might want to consider only birds that have some sort of endangered 
status, or limit the query to only shorebirds. Life history is an important consideration when 
determining protection priorities. In the next step, you will restrict your selection to birds 
that are nesting in April. 
 
b) Again click on the Query Biology by Attribute tool.  

1. Set Biology Layer to “birds” 

2. Check the Apr seasonality box 

3. Check the Breed1 box (Double click on a Breed heading; you will see the 
activities to which it refers depending on the element being queried.)  

4. Check the Limit query to currently selected objects 

5. Click OK. 

This reduces the number of selected records to 21, but more importantly, it has limited the 
area selected to Gailliard Island and a few of the inland polygons selected due to the 
buffering of the trajectory. This knowledge may be helpful in determining how to best use 
limited response resources.  

 
 

Task 9: Create a report of birds nesting in April 

It may be useful to have a report listing the affected bird records found within the spill 
trajectory. The Resource at Risk Report tool gives you two options for generating a report. 
You may choose to export all of the selected records, along with all of the fields you have 
displayed in the onscreen biofile table, or you may choose to export a list of only the unique 
species selected. The second option will export one record for each species, along with the 
information that does not change from polygon to polygon.  

 
a) Click on the Resource at Risk Report tool  
 
b)  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Select the list of unique species option

Type in a header line for the report 

Click OK
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c) Select the destination folder and name the output report. 

d) The output will be a tab delimited text file. You may need to adjust the tabs on your 
document, and you may also want to alter the font or style to make the report easier 
to read. The output can also be brought into any spreadsheet or other program that 
accepts tab delimited input. 

 

 
 
You could go through the steps above and do similar queries with the other biological 
layers. The results can be added to this report by giving the report the same name, and 
choosing the option “append”. At this time it is only possible to export biology records 
to the report. 
 

Task 10: Identify the source of the selected bird records: 

Knowing the source of the information you are viewing may help identify possible 
expert contacts to coordinate with during a spill event. The attributes found in the ESI 
source table can also give you a greater understanding of the data you are seeing. For 
instance, there is both a date published and time period date listed to help evaluate the 
currency of the data. With document sources, the title may provide some insight into 
the purpose of the original data collection effort.  
 
There are object level metadata for all of the biology and human use features. This 
means you can look at a polygon or group of polygons, and determine the document or 
expert that provided both the geographic (location and extent) information and the 
related seasonality data. Many times these sources will be the same, but there are 
occasions when these data come from different places or from multiple sources. In this 
task, we will look at the process for viewing the source records related to the birds we 
determined to be nesting in April within our spill area. Retrieving the source 
information is not a direct process, but it isn’t really too difficult. At some time, a tool 
may be developed to make this more of a one step process for the end user. Remember 
to look for updates and new tools on the ESI website! 
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 From the biofile window, click on options then highlight Related Tables -> ssourcerel: 
 

 
ArcMap will open the sources window, and the appropriate records will be 
highlighted. Choose to show only the selected records; there are only two. Below you 
can see the types of information stored in the sources table. The link between these 
files is a relate that goes from the Seasonality Source field in the biofile to the 
Source_ID in the sources file. If you try this same process with gsourcerel you will 
find you get these same two records and an additional source record. This relate goes 
from the Geographic Source field in biofile to the Source_ID in sources. If for any 
reason the the relates do not work, or the ESI tools are not working with the ESI data, 
you can redfine the relates. This process is described in Appendix C. Understanding 
how the relates are set up and knowing the naming conventions expected by the tools 
will also help you if you want to use the ESI data in a map document other than the 
.mxd provided with the atlas.  
 

 
 
 

Task 11: Use the ESI select layer tool to identify the impacted Human Use Resources:  

This process basically duplicates the steps followed in Task 6. This time we will look 
at the human use resources found in the socecon layer. 

a) Turn off  the visibility of the birds layer; turn on the layer socecon 

b) Set the layer to query using the ESI select layer tool . As shown below, select socecon 

1 
2 

3 
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c) Click the Select the fields to display 
button. In the pop-up window, you 
have the option of setting the soc_dat 
fields that are of interest. Here we 
choose to see just the general 
information and to exclude the link 
fields. 

d) Click OK  in both windows to 
continue. 

 
 
 
 
As was the case with the biology 
layers, once the socecon layer has 
been selected, you may use any of 
the ArcMap methods to select 
objects and view their attributes. 
Use the Select Features tool  to 
examine a few of the socecon 
points. Their attributes will be 
displayed in the soc_dat table.  
 
 
 
Now we will use the Select by Location option to identify the socecon points impacted 
by the trajectory.  The method is the same as we saw for the shoreline selection and 
the bird selection. If necessary, refer back to steps a and b of Task 5 for a graphical 
example of how to set the Select by Location criteria. 

 
g) Under the Selection menu, choose Select by Location. Set the selection criteria as 

follows:  

1. I want to: Select features from: 
2. the following layer(s): socecon (make sure all other layers are unchecked) 
3. that:  intersect 
4. the features in this layer: trajectory 
5. apply a buffer to the features in trajectory of: 250 meters 
6. Click OK 

 



 32 

 

Seven soceon points are selected by our search. The associated attributes are shown below:  

 

 

In the Alabama atlas, there isn’t any contact or phone information listed for the socecon 
objects. The other human use layer, management does contain this information. If you 
would like, make that layer visible and using the ESI tool, set it to the layer to query. Select 
a few random polygons to see the types of information provided. 

 

Task 10:  Check out the metadata! 

Published with all ESI atlases are very detailed metadata reports. These documents contain 
all types of information about the data coverage and extent, collection and processing 
methods, sources, etc. Imagine you have a particular interest in the Northern pintail. You see 
that it does not appear in the list of nesting species within the trajectory area, but cannot tell 
if that is because it does not occur there or if perhaps that species wasn’t mapped for this 
atlas. The metadata can help answer this question. 

a) Click on the Metadata tool.   This launches Adobe Acrobat and opens the metadata 
document. 

b) Under the bookmarks on the left side of the page, highlight Birds.  

c) Scroll down to the Completeness Report. This section lists all of the bird species that 
were mapped in this atlas. You will see that species number 17 was the Northern pintail, 
and that it was, in fact, mapped in the Alabama atlas.  

This does not necessarily mean that the Northern pintail does not live in the spill impacted 
area, but it does mean that for whatever reason, its population wasn’t felt to be significant 
enough to show in this area. Or it may mean that the species was ruled out by virtue of our 
selection criteria, i.e. that the bird be present in April and that it be nesting.  

Once again this emphasizes the importance of contacting local experts and on-site biologists 
as soon as possible after an actual spill event. The ESI provides useful baseline information 
quickly and easily, and is an ideal starting point for assessing potential resources at risk. 
Still, it is a snap shot in time and it does not attempt to map everything that may be of 
interest during an event. The metadata provides source information, so it is another resource 
for identifying the local experts. As you saw in the previous sections, source and expert 
information may also be found in the introductory pages of the hard copy or PDF atlas, as 
well as in the object level metadata in the sources table. 

 
 



 33

 
 
 

Section 3: Using the ESI Viewer 
 

The ESI Viewer merges a free mapping program, Marplot, with a stand alone Filemaker 
application, to give those without access to ArcMap a way to view and query the digital 
ESI data. There are Macintosh and Windows versions of the Viewer. On the Macintosh, 
the latest software requires a post 10.3 version of Mac OS X be installed. The Windows 
version requires a minimum of Windows 2000 - service pack 4 or Windows XP - service 
pack 2. Other than a slight difference in the installers and how to launch the program, the 
functionality of the software is virtually the same on either platform.  

 

Install the ESI Viewer software: 

Windows: 
e) From the ESI_Training/ESI_VIEW/Windows directory, double click the 

installer icon  (If you are running Vista, you will 
need to be logged on as an administrator and will be asked for your 
password). 

f)  A set up wizard is launched. To accept the default settings 
(recommended), simply click on Next in the following four windows 

g) On the final window, “Completing the Set Up Wizard” click on Finish 

 

Macintosh: 

a) From the ESI_VIEW/Macintosh directory, double click the installer icon: 
 

b) Type in an administrator name and password. (This is a security measure of 
the OS-X operating system, as part of this process will install the 
MARPLOT font) 

c) In the next window select Install.  
d) The default will be to install the software in your Applications directory. 

To accept this, click Choose.  

e) After the install is complete, click OK on the “successful installation” 
window. 

The ESI Viewer software is now ready to use.  

 

Launch the ESI Viewer  
 Windows: Double click on the desktop shortcut Alabama ESI Viewer or launch 

the applications from All Programs > ESI Viewer > Alabama 

 

 Macintosh: Double click on the Alabama ESI Viewer  icon found in Applications 
> ESI Viewer Alabama. 
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Maximize the view of the database window:  
Click on the two icons shown below, then, if necessary, adjust the window size to 
accommodate the larger Welcome… screen. Hit Continue. 

 
 

 
The next window you see is the database list view: 

 

1

2

3
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Currently there are no records selected, so every record in the database is visible. The 
list view shows basic information about each species in a resource at risk (RAR) 
group. This includes the species’ common name, threatened and endangered status, 
concentration (if known) and the months each species is present in the area. 
(Remember, an RARNUM defines a group of species found together in a mapped 
polygon or point. The same grouping (therefore the same RARNUM) may appear in 
multiple places on a map or within the atlas) 
 
If you would like more detail about any of the species records found in a particular 
RAR group, just highlight the line where that species appears. This will take you to a 
detailed screen as shown below. Here, among other things, you will find information 
about breeding activities, the species’ scientific name, and the source metadata. This is 
also the screen where you can formulate a query based on attributes. 
 
 

 
 

Object level source metadata 
(Scroll down to see Seasonal source if not 
the same as the geographic source) 

Monthly breed 
summary 

Formulate query by attribute 

Threatened/ 
Endangered 
Status

Searchable seasonal and 
breeding information 
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Go to the MARPLOT Map 
Circled on the detail screen illustration is the Go To Marplot button. Click here to launch 
the mapping side of the ESI Viewer; on the startup screen, click OK. Your screen should 
look similar to that shown below, with only the hydro and index layers visible. If Marplot 
has been run previously on the computer other layers may be turned on, as the program 
remembers the settings from the prior session.  

 

 
 
 

Task 1: Create a trajectory layer: 
Unlike ArcMap, Marplot can not directly import the GNOME trajectory output. That 
means the first task will be to draw a polygon to represent the confidence limits of the 
trajectory for our scenario. To do this we will create a new layer called “trajectory”.  
While in the layer dialog box we can do some other “housekeeping” to help get ready for 
the tasks to follow. 
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By default, the trajectory layer just created is unlocked, meaning it is editable. 
On the left side of the screen, a new palette of draw tools has been added. To 
create the trajectory outline, we will use the polygon tool. 

 
 
 
 
 
 
Refer back to the trajectory output at the beginning of this tutorial. If you are working with 
an ESI atlas other than that on the training CD, you can follow these same steps to draw in 
a trajectory for your own scenario.  

Polygon draw tool 
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h) Zoom into the area that is impacted by the trajectory 
i) With the polygon draw tool, click to enter the points to define the trajectory polygon. 

When you are finished, double click and the polygon will close. The following dialog 
box will appear: 

 
 
 
- Leave the name as “untitled” or  
  change it to “April 18 1800” to  
  reflect the time of the trajectory 
 
- Set the Polygon Color to red 
 
- Use the default Line Style 
 
- Set the Fill Pattern to hollow 
 
- Click OK 
 
 
 
 

Your map should now look something like this: 
 

 

The trajectory is not clipped to the shoreline, but overlaps it a bit so any geographic 
queries will include the shoreline and some of the inland polygons. If you want, you 
can go back under the menu item List > Layer List and move the trajectory under the 
shoreline, so it is more visually pleasing. We will do this next time we need to turn a 
layer off or on.
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Task 1: Identify the ESI types of the impacted shoreline segments: 

 

a) Zoom in to the area impacted by the trajectory 

b) Using the Arrow tool, click on a shoreline segment; it will be highlighted as shown 
above 

c) In the lower left corner of the screen, you will see the shoreline type of the selected 
segment. In this case it is an ESI-10A/6B: Salt & brackish water marshes/Riprap 

This is a very simple way to identify the ESI type of single shoreline segments. Now we will 
look at a way to get a listing of all the impacted shoreline segments. 

d) Using the Arrow tool, click on the line defining the spill trajectory 

e) Under the menu item List, select Search… 

 
 

Selected segment 
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You will see that a total of 44 map objects are selected. This includes both ESI line 
segments (  ) and ESI polygons ( ). Scroll through the list to see types of shoreline 
present that might need to be protected. Remember, the higher ESI numbers reflect the 
more sensitive shoreline types. 

 
There is not a direct way to export these shoreline segment types in order to create a 
report. However, the steps below enable you to bring attributes – including the ESI 
type - of the selected polygons and lines into a space delimited text file that can be 
cleaned up using Excel or another spreadsheet program. At this time, it is not possible 
to save the length or area of the objects. 

f) From the Search Collection window, click on Show All on Map; all of the impacted 
shoreline segments and polygons will be selected (there will be lines and polygons 
outside of the selected area selected – this is because at least a portion of that object falls 
inside the trajectory line) 

g) Under the menu item Export…, choose to export the selected objects in MARPLOT 
Simple Point Format; Click Export 

       

f
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The output will be a text file. This can be opened in Excel where the extraneous fields 
can be removed. The file will have the polygon objects listed first, then the line 
objects. It will look something like what appears below. 

 
 

Task 2: Identify the impacted biology: 
 
The first part of this task will be to simply select and query a few of the bird polygons. To 
do this, the bird layer must be visible. When we turn it on, we will also move the 
trajectory layer to the bottom of the drawing order, so it doesn’t display on top of the land. 
As in task 1, where we created the trajectory layer, it will be necessary to go into the layer 
list view. 

a) Under the MARPLOT menu List, select Layer List 

 b   
 

b 

d 
c 

e 
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b) Set the BIRDS layer to Show 

c) Verify that the radio button draw order is selected 

d) Highlight the trajectory layer 

e) Click on Move… and select Bottom 

f) Scroll down the layer list and set the ESI layer to Hide 

g) Click OK 

In the ESI Viewer, as long as the layers are visible, it is possible to select and 
query multiple elements at the same time. For now, we will just choose a few 
bird polygons to get an idea of how the mapping program and data base work 
together. 

h) Using the arrow tool, select a bird polygon. (If you want to select 
more than one bird polygon, hold down the shift key and select 
additional map objects – OR – click and drag the mouse over the 
polygons you want to select, then highlight BIRDS and hit Select.) 

i) Under the MARPLOT Sharing menu, select Alabama ESI -> Get 
Info, or, use the keyboard shortcut Ctrl + I. 

 

 
 

This brings up a database window in list view that shows the birds present in the 
selected polygon(s). To return to the map you can click on Go to MARPLOT in the 
bottom right corner. If you would like to see if there are other polygons with the same 
combination of species, click Show on Map. This will select all of the polygons that 
have exactly the same species with the same seasonality as the polygon you selected.  

Get Info or Ctrl + I
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Now we will identify the birds impacted by the spill trajectory. Use the zoom and pan 
tools to get to a view of the map where you can see the area covered by the trajectory.  

j) With the arrow tool, click on a portion of the trajectory outline, to select the trajectory 
polygon 

k) On the MARPLOT menu, select List -> Search… 
l) In the Search Criteria window use the following settings from the drop-down menus: 

1) Search for objects that:  are inside of or touching… 
2) the currently selected object(s) 
3) Layers(s) to search: 

i) Individual Layer… (If you had other biology layers you wanted to search, 
you would make them visible and select Multiple Layers…) 

ii) BIRDS 
m) Replace previous collection 
n) Click on Search 

 



 44 

o) The search collection window will show there were ten bird polygons found that were 
inside or overlapped the trajectory. To select all of these polygons, click on Show all 
on Map.    

p) From the MARPLOT window, under the Sharing menu, select Alabama ESI -> Get 
Info, or, use the keyboard shortcut Ctrl + I  to get a list of the selected bird records. 

 
There are 79 bird records selected (look under Found: on the left hand side of the Viewer 
window). Scroll down to see the list of all the selected records. 
 
Task 3: Find where birds are nesting inside the spill trajectory: 

With the ESI Viewer, the process of identifying the nesting bird records within a particular 
area is backwards from the process performed in ArcMap. First, all of the birds nesting in 
April are identified. Then the polygons they occupy, that fall inside the spill area are 
selected. 

From the ESI Viewer List View window, click the Find… button in the bottom right hand 
corner of the screen.  

 

a) On the Find… screen, set Element to ‘BIRD’ 

b) Under Breed:, set the month to ‘Apr’, and Breed1 to ‘Y’ 

c) Click on Find. The List View comes back with 700 records selected.  

d) From the List View, click on Show on Map in the bottom right hand corner. 

a 

b 

c 



 45

Now you will be on the MARPLOT screen with all of the polygons that have any birds 
listed as nesting in April selected. We want to narrow this down to only the selected 
polygons that fall within the trajectory area. With just a few modifications, this will be the 
same process we performed in task 2, steps j to n.  

e) Under the MARPLOT menu List, select the option Copy to Search Collection. 
MARPLOT will now “remember” the selected polygons, so they will be the only ones 
considered in our search. 

f) With the arrow tool, select the trajectory polygon. 

h) On the MARPLOT menu, select List -> Search… 
i) In the Search Criteria window use the following settings from the drop-down menus: 

i. Search for objects that:  are inside of or touching… 
ii. the currently selected object(s) 

iii. Layers(s) to search: 
1. Individual Layer…  
2. BIRDS 

j) In the bottom right hand corner, choose to save a Subsearch of the previous collection.  
k) Click on Search. 
l) Choose Show all on Map. This will select only the bird polygons that fall within the 

spill area that also have birds nesting in April. Depending on how you drew the 
trajectory, you should have seven polygons selected and the selection should look 
similar to the screen shot shown below. 

     

Focusing on the areas where the most vulnerable birds are found in April (when the spill 
occurs), makes it easier to formulate an appropriate protection strategy when limited 
response equipment is available.  
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Task 4: Create a resource at risk report:  

All of the currently selected polygons represent areas where birds will likely be found 
nesting in April. However, when we query the database, we will also get a list of all 
the other bird species they represent. Unfortunately, from the MARPLOT List View, 
there is no obvious way to differentiate between the nesting and not nesting records. 
This is a limitation of the ESI Viewer.  

Below are two ways to create a resource at risk report. The second method shows how 
to include the monthly breeding summary so at least visually it is possible to identify 
the species that are nesting. 

Method 1: 

a) From MARPLOT, under the Sharing menu, select Alabama ESI -> Get Info, or, 
use the keyboard shortcut Ctrl + I. 

b) In the bottom right corner of the List window, click on Print List. This is the 
easiest way to produce a hard copy or PDF version of the report. Remember, this 
list will include all of the birds found in the selected polygons.  

Method 2: (illustrated on the next page) 

a) From MARPLOT, under the Sharing menu, select Alabama ESI -> Get Info, or, 
use the keyboard shortcut Ctrl + I. 

b) Under the File menu, select Export Records… 

c) In the Export Records to File window: 

1. Navigate to the directory where you want to save the report. 

2.  Use the drop down Save as type menu to select the type of file to create. (In 
the example diagram, the file will be exported into an Excel spreadsheet. 
You may need to use the scroll bar to see this option).  

3. Name the report 

4. Click on Save 

d) In the Excel Options window, click on Continue. 

e) In the Specify Field window, highlight the items you wish to save in your report 
and click Move to move them into the export list on the right side of the screen. 
Choose to export _RAR_Num, Element, Name, Gen_Spec, Conc, S_F, T_E, Apr, 
and Breed1. 

f) Click on Export. 

g) Navigate to the directory where the Excel report was saved, and open the report.  

On the following page is a schematic of the Method 2 process, as well as a sample of 
the Excel output. 
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Schematic of Method 2 Risk Report 
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Conclusions 
 
The intent of these exercises is to demonstrate the content of the ESI maps and database as 
well as provide an introduction into three of the ESI distribution formats. These techniques 
can be extended to other scenarios and types of queries. Although this example looks at 
resources impacted by an oil spill, the content of the ESI maps may be useful in any number 
of different types of applications, such as coastal planning and permitting, habitat protection 
and restoration, tourism management, etc. 
 
Whenever using the ESI maps, keep in mind they reflect a snapshot in time. The maps 
should be used as a starting point. The metadata, introductory pages and source information 
can guide you to local resources who can confirm the presence of the biologic resources 
mapped and provide updates on life stages present and other important considerations. 
 
At this time about one half of the ESI maps are available in the formats presented here. An 
effort is underway to redistribute many of the older atlases in these formats as well. This is 
in addition to the cyclic updates of the ESI data as funds are available. All of the new ESI 
atlases will be published in these, as well as other, GIS formats. Check the ESI website 
(http://response/restoration.noaa.gov/esi) for atlas availability and additional tools (or 
updates to tools) for the ESRI geodatabase.  
 
Any comments or questions on this tutorial or ESIs in general may be sent to: 
orr.esi@noaa.gov. 
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Appendix A – Zones and Longitude Ranges for the UTM Projection 
 
 

Zone Central Meridian Longitude Range 

1 177W 180W – 174W 

2 171W 174W -168W 

3 165W 168W – 162W 

4 159W 162W – 156W 

5 153W 156W – 150W 

6 147W 150W – 144W 

7 141W 144W – 138W 

8 135W 138W – 132W 

9 129W 132W – 126W 

10 123W 126W – 120W 

11 117W 120W – 114W 

12 111W 114W – 108W 

13 105W 108W – 102W 

14 99W  102W – 96W 

15 93W 96W – 90W 

16 87W 90W – 84W 

17 81W 84W – 78W 

18 75W 78W – 72W 

19 69W 72W – 66W 

20 63W 66W – 60W 

21 57W 60W – 54W 

22 51W 54W – 48W 

23 45W 48W – 42W 

24 39W 42W – 36W 

25 33W 36W – 30W 

26 27W 30W – 24W 

27 21W 24W – 18W 

28 15W 18W – 12W 

29 9W 12W – 6W 

30 3W 6W – 0 

 Zone Central Meridian Longitude Range 

 31 3E 0-6E 

 32 9E 6E-12E 

 33 15E 12E-18E 

 34 21E 18E-24E 

 35 27E 24E-30E 

 36 33E 30E-36E 

 37 39E 36E-42E 

 38 45E 42E-48E 

 39 51E 48E-54E 

 40 57E 54E-60E 

 41 63E 60E-66E 

 42 69E 66E-72E 

 43 75E 72E-78E 

 44 81E 78E-84E 

 45 87E 84E-90E 

 46 93E 90E-96E 

 47 99E 96E-102E 

 48 105E 102E-108E 

 49 111E 108E-114E 

 50 117E 114E-120E 

 51 123E 120E-126E 

 52 129E 126E-132E 

 53 135E 132E-138E 

 54 141E 138E-144E 

 55 147E 144E-150E 

 56 153E 150E-156E 

 57 159E 156E-162E 

 58 165E 162E-168E 

 59 171E 168E-174E 

 60 177E 174E-180E  
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Appendix B – Creating a trajectory layer in ArcMap 
 
 
 
To make your own trajectory layer, you first need to create a shapefile to put it in. This 
requires ArcCatalog. 
 
Task 1: Create a shapefile: 
a) Launch ArcCatalog. 

b) Select a folder or folder connection in the Catalog tree.  

c) Click the File menu, point to New, and click Shapefile.  

d) Click in the Name text box and type the name “Trajectory”  

e) Click the Feature Type drop-down arrow and select Polygon 

f) Click Edit to define the shapefile's coordinate system.  

1. Select Import… 

2. Browse to the directory where the ESI geodatabase resides 

3. Double-click on the geodatabase icon  

4. Select hydro_polygon as the coordinate system to use 

5. Click OK to accept the new coordinate system 

6. Click OK in the New Shapefile dialog box to complete the process 

g) Close ArcCatalog 

 

 

Task 2: Set up an edit session:  
a) Launch the Alabama ESI map project by double-clicking the alabamaESI.mxd icon, or 

by opening it from within ArcMap (for simplicity, the Alabama ESI is referenced here, 
but you can use these instructions with which ever ESI atlas you are using.) 

b) Click the Add Data button , and add the Trajectory file you created in Task 1 

c) Under the menu Tools, select Editor Toolbar (if the toolbar is not already visible) 

d) On the Editor toolbar, click the drop down menu Editor and select Start Editing. 
a. Set the folder or database source to the directory where the Trajectory file resides 

b. Click OK 

e) From the drop down menu Task, select Create New Feature 

f) From the drop down menu Target, select Trajectory 
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Task 3: Sketch the trajectory footprint 
a) Zoom into the area where you want to place the trajectory footprint 

b) Using the sketch tool , click where you want the polygon to start 

c) Continue the polygon sketch by clicking where you want the shape points 

d) When your shape is defined, double click to have the polygon auto-complete 

 

Since we only use the uncertainty bounds in our resource analysis, there is no need to enter 
any other polygons. 

 

e) Under the Editor drop down menu, select Stop Editing 

f) When prompted whether to save your edits, click Yes 

 

 

Task 4: Clip the trajectory to the shoreline 
Although the following method may seem a bit convoluted, it was chosen because it can be 
completed successfully with any ArcMap license. 

a) If it is not visible, add the toolbox by clicking the toolbox icon  

b) In the toolbox, navigate to Analysis Tools -> Overlay -> Union and double click  

c) Under Input Features, use the drop down menu to select and add the layers Trajectory 
and Hydro 

d) Under Output Feature Class, navigate to the directory where you want the output stored 

;, and name the shapefile Trajectory2 

e) Click OK 

f) On the Editor toolbar, use the drop down menu under Editor to select Start Editing 

g) Set Task: to Create New Feature, and Target: to Trajectory2 

h) Under the main menu, go to Selection -> Select by Attributes… 

i) Set the Layer to Trajectory 2, Method to Create a new selection 

j) Set your query to "WATER_CODE" <> ' ' 

k) Click OK. 

l) At this point, all of the polygons that are not in the open water should be selected. Use 
the Delete key to remove these polygons. 

m) Under the Editor drop down menu, select Stop Editing. When prompted choose to save 
your edits. 

 
You may now symbolize the Trajectory2 layer. Choose a polygon with no fill and an outline in 
red to match the standard trajectory colors. Trajectory2 is now ready for use in place of the 
GNOME trajectory imported in the ArcMap example.  
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Appendix C – The ESI tools and Relates in the ESI Geodatabase 
 
Each atlas comes with a map document (.mxd) that has the ESI data loaded, symbolized 
and linked to the data tables. In order for the ESI tools to work, these links (relates) 
must be established and have specific names that the tools will recognize. If at any time 
the relates quit working, or if you want to put the ESI data into another map document, 
the following will guide you through the requirements and naming conventions for 
establishing the ESI data links. Layer files are also included on the ESI CD/DVDs. 
These are located in the same directory as the ESI .mxd. The layer files have the 
symbolization and relates set up and can be loaded into other map documents. As long 
as the attribute tables (see step a below) are also loaded into the .mxd, the tools should 
function properly.  

a) Use the add data tool  to load the attribute tables.  To query the biology 
layers, you will need to have the biofile and breed_dt tables loaded into the 
.mxd. To query the human use layers (socecon points and management), you 
will need to have the soc_dat table loaded. You may also want to load the 
sources data table, as both the biofile and the soc_dat table have links to this as 
well.  

 
To check if the attribute tables have already 
been loaded, click on the Source tab at the 
bottom of the table of contents.  Any data 

tables you have available 
will be listed in the window above. 

 
 
 

b) Define the relate between any biology layer and the biofile.  
 
1) Right-click on the desired  
    biology layer 
 
2) Select Joins and Relates >  
    Relate… 

 
        3) In the Relate dialog box, set: 

1. …field in this layer…. to RARNUM 

2. …table or layer to relate to… to biofile 

3. …field in the related table… to RARNUM 

4. …name for the relate: to biorel 
 
c) Repeat this process for any of the biology 

layers you wish to query. 
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d) Set up the relate between the biofile and the breed_dt file. Follow the same 
steps shown above…  

1. Right-click on the table name biofile 
2. Select Joins and Relates > Relate… 
3. Set the dialog box as follows: 1) BREED, 2) breed_dt, 3) BREED, 4) 

breedrel 
e) Set up the relates from the biofile to the sources table for the geographic source: 

1. Right-click on the table name biofile 
2. Select Joins and Relates > Relate… 
3. Set the dialog box as follows: 1) g_source, 2) sources, 3) source_id, 4) 

gsourcerel 
  Then set it up for the seasonality source: 

1. Right-click on the table name biofile 
2. Select Joins and Relates > Relate… 
3. Set the dialog box as follows: 1) s_source, 2) sources, 3) source_id, 4) 

ssourcerel 
f) Define the relates between the human use layers (socecon points and management) 

and the soc_dat file: 

1. Right-click on the desired human use layer name  
2. Select Joins and Relates > Relate… 
3. Set the dialog box as follows: 1) HUNUM, 2) soc_dat, 3) HUNUM, 4) 

socrel 
g) As in step e, define the relates from the soc_dat table to the sources table, only 

name the geographic relate gsource and the attribute source asource 

 
Following these steps, you should be able to use the ESI data and the ESI tools in either 
the .mxd provided, or in any map project you may already have set up for an area. Just 
remember, it is imperative to keep the names of the relates as specified here in order for 
the ESI tools to recognize the relationship. All links between the ESI tables are set up as 
relates (not joins), as in all cases the relationship between tables is many to many. 
 
 




